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MANDARIN M3® TEXTBOOK MODULE

The Textbook Module adds a textbook database to your M3 system, allowing you 
to track, catalog, and maintain your textbook collection separately from your 
library collection. 

Unlike other library automation systems, M3 has textbook capabilities integrated 
into each client module, eliminating the process of transferring or re-entering stu-
dent and textbook data into a separate textbook module. All textbook functions 
are performed in M3 Cataloging, M3 Circulation, M3 OPAC, M3 Inventory, M3 
Group Editor, and ReportTool.

The Textbook Module CD also includes 20 textbook-related reports. For more 
information, see “Using the Reports” on page 7.

This document describes:

• How to install the Textbook Module

• How to generate barcode labels for your textbooks

• How to perform textbook functions in M3 

INSTALLING THE TEXTBOOK MODULE
Note: You must have M3 
Server version 1.6 installed 
prior to installing the Text-
book Module.

The Textbook Module must be installed on your server. 

1. Insert the Textbook Module CD into the server’s CD-ROM drive. 

2. Navigate to the CD-ROM drive (D: on most computers) and double-click 
TextbookModInst.exe.

3. In the Welcome dialog box, click Next to begin installation.

4. In the License Agreement dialog box, review the agreement and click Yes 
to accept and continue the installation. Or, click No to discontinue. 

Note: To install the Textbook 
Module into more than one 
location, you can rerun 
TextbookModInst.exe 
multiple times, selecting a 
different location each time in 
step 5.

5. If you are using the Multiuser version of M3, the Select M3 Data Location 
dialog box displays. You can install the Textbook Module into the location 
that displays in the box (your default server folder), or you can click Browse 
and navigate to a different location. Then click Next.

6. The module downloads, then the Database Adder dialog box displays 
(Figure 1).
© Mandarin Library Automation, Inc.



 

2

                                     
7. In the Select a Port box, select the port that you want to have access to the 
textbook database, and then click Connect.

8. The entry Textbook appears in the New Database’s Name box. If you want to 
give your textbook database a different name, edit this entry. 

9. In the Choose a Site box, select the site that you want to have access to the 
textbook database. 

10. If you want to share the textbook database with other databases, select the 
Share With check box and select a database in the corresponding list. 

NOTE: If you choose to share, the textbook database will have its own bib-
liographic and holdings tables, but will share the barcode, group, message, 
transaction, patron, and session tables with the database you selected.

11. When finished, click Add Database. At the confirmation prompt, click OK. 

12. In the Setup Complete dialog box, click Finish. 

13. If you have MARC records for your textbooks, import them into the text-
book database. Otherwise, you will need to create bibliographic and 
holding records for your textbooks. For instructions on either procedure, 
refer to Chapter 4, “Using Cataloging,” in your M3 Users Guide. 

GENERATING BARCODE LABELS
M3 includes a Barcode Labels utility that allows you to create and print barcodes 
for items in your collection. 

1. On the taskbar, click the Start button, select Programs, select Mandarin M3, 
select Utilities, and then click Barcode Labels. This displays the Barcode 
Labels window (Figure 2).

FIGURE 1
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2. In the upper pane, select the Avery label you want to use, then type the 
library name you want to appear on the printed barcode. 

3. In the first barcode box (shown in Figure 2), type the first barcode in the 
sequence, and then click Create. This fills each of the barcode boxes with 
a barcode based on your first entry incremented by +1. For example, if 
you type 1000, then next entry will be 1001, then 1002, and so on.

4. If you want to preview the barcode labels, click Screen in the Print To box, 
then click the Print button. When you are ready to print the labels, click 
Printer in the Print To box, then click the Print button.

Note: If 852#p does not 
appear in the record, add it. 
Right-click in the record, 
select Insert Field, select 852, 
then click OK. Then select p 
and click OK.

5. You now need to assign a barcode to each textbook holding record. To do 
so, search for the holding record in the Cataloging module. When it dis-
plays in the main window, double-click it. The record now displays in the 
lower pane of the Holding - Cataloging window (see Figure 3). Click in 
field 852#p and then scan the holding’s barcode with your barcode 
scanner. The barcode will appear in the 852#p field. Click Save in the 
holding window and repeat for each holding.

USING YOUR TEXTBOOK DATABASE IN M3
In M3, you can use your textbook database as you would your library database: 
you can catalog, circulate, search for, generate reports for, inventory, and perform 
other functions with your textbooks.

Using the M3 OPACs
To search your textbook database in the Windows OPAC or Web OPAC:

Note: If you do not want the 
textbook database to appear 
in the OPAC, contact 
Mandarin Technical Support 
for assistance.

1. On the Databases tab (Windows OPAC) or the Preferences tab (Web OPAC), 
select the check box next to the textbook database. If any other databases 
are selected, clear the check box next to each one.

2. Click Apply (Windows OPAC) or Submit (Web OPAC). 

3. Click the Search tab and conduct your search.

FIGURE 2

First barcode box

Tip: You can change the 
font size of the printed 
labels by clicking 36 or 26 
in the Font Size box.
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Using M3 Cataloging
Once textbook records are in your M3 database (created or imported through the 
Cataloging module), you can perform all textbook cataloging functions including 
adding, editing, and deleting data. 

To access the textbook database in Cataloging:

1. On the File menu, click Change Database. This displays the Change Data-
base dialog box. 

2. In the Current Database list, select the textbook database, and then click 
OK. You can now perform all cataloging functions in this database. 

TIPS:

• In the holding record, use the 995#a field to enter a textbook’s con-
dition. The default choices are New, Good, Fair, Poor, and Unusable.

• In the patron record, use the 852#b field to enter each student’s hom-
eroom or the 852#c field to enter each student’s teacher. You can then 
check out textbooks by class; to do so, perform a search for the hom-
eroom teacher in Circulation (selecting Homeroom or Teacher in the 
drop-down list in the Patron Search dialog box) to obtain a list of all 
students in the class, allowing you to check out a textbook to each stu-
dent.

• In the holding record, use the 852#9 field to record each textbook’s 
price. This will be the amount of the fine if the item is lost by the stu-
dent.

Adding Holdings to Textbook Records
The Cataloging module makes it easy for you to add multiple holdings to a text-
book record.

1. Search for the bibliographic record of the textbook you want to add hold-
ings to. You search results appear in the upper pane of the main Cata-
loging window. 

2. Click the bib record in the upper pane. Then do one of the following:

• If a holding record similar to the one you want to create appears in the 
lower pane, use this as a template. Click the holding record, then click 
Duplicate on the Edit menu. 

• If no similar holding record exists, select New on the File menu, and 
then click Holding Record. (If more than one holding template is avail-
able, the Templates dialog box displays. Click the desired template, 
then click OK.) This displays the new holding record in the Holding - 
Cataloging window (Figure 3). 
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3. In the lower pane, enter field and subfield data for the holding records.

4. Select the Generate Holdings check box. This activates the boxes below.

A. In the Quantity box, type the number of holdings you want to add. 
NOTE: This number is in addition to the holding records that already 
exist for this bibliographic record.

Note: The prefix and suffix 
values are assigned in 
852#p.

B. If the record’s barcode has a prefix, it appears in the BC Prefix box. 
Modify if desired. If the barcode does not have a prefix and you would 
like to add one, type a value in the BC Prefix box.

C. The barcode suffix appears in the Start box. Modify if desired. The 
suffix must be a numeric value and will be the starting value for the 
barcodes of the new holding records. 

D. In the + box, type the number for the suffix to increment by. For 
example, if the values are 1000 in the Start box and 2 in the + box, 
the first holding record will be assigned a barcode of [Prefix]1000 and 
the next holding record will be assigned [Prefix]1002.

5. When finished, click Save. (NOTE: If a barcode you chose already exists, 
an error message displays and no holdings are created. Click OK and 
modify the value in the Start and/or + box, then click Save again.)

FIGURE 3

Generate Holdings check box

Bibliographic record

Holding record
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Using M3 Circulation
You can perform all textbook circulation functions including check out/check in, 
renewals, viewing status, adding student fines, recording condition of books, and 
reporting books as lost. 

To use the textbook database in Circulation:

1. On the File menu, click Change Database. This displays the Change Data-
base dialog box. 

2. In the Current Database list, select the textbook database, and then click 
OK. You can now perform all circulation functions in this database. 

Several common procedures are described in the following sections. Instructions 
for all circulation functions are available in Chapter 5, “Using M3 Circulation,” in 
the M3 Users Guide.

Checking out a Textbook to a Student
1. On the Circulation toolbar, click Loan.

2. If you are using a barcode scanner, scan the student’s barcode, then scan 
the barcode of each textbook you want to loan to this student. 

OR

A. In the Barcode box, type the student’s barcode, and then press ENTER. 

B. In the Barcode box, type the textbook’s barcode, and then press 
ENTER. Repeat this step for each textbook you want to loan to this 
student. 

The textbooks are now loaned.

Checking in a Textbook from a Student

1. On the Circulation toolbar, click Return.

2. If you are using a barcode scanner, scan the textbook’s barcode. 

OR

In the Barcode box, type the textbook’s barcode, and then press ENTER. 

Tip: The available conditions 
are New, Good, Fair, Poor, 
and Unusable. 

3. The textbook is now returned. To record the textbook’s condition: 

A. Right-click in the pane where the textbook’s data appears (the pane 
on the right). In the menu, click Edit.

B. In the Edit Holding Record window, look near the bottom of the 
window for the field titled Condition (field 995). 

If the Condition field does not appear, add it. Right-click in the record 
and select Insert Field. In the Insert Field dialog box, select 995-Condi-
tion, then click OK. In the Insert Subfield dialog box, select a-Condition, 
then click OK. The field now appears.

C. Click the arrow next to the Condition field on the right side of the 
window. In the list, select the desired condition, then click OK in the 
Edit Holding Record window.
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Viewing the Status of a Student or Textbook
1. On the Circulation toolbar, click Status.

2. If you are using a barcode scanner, scan the student’s or textbook’s bar-
code. 

OR

In the Barcode box, type the student’s or textbook’s barcode, and then 
press ENTER. 

3. The status of the student or textbook appears in the window; any open 
transactions are listed in the lower pane.

Using the Reports 
The Textbook Module CD includes a report pack of 20 textbook-related reports, 
which you can generate using ReportTool. To download these reports: 

1. Insert the Textbook Module CD into the workstation’s CD-ROM drive. 

2. Navigate to the CD-ROM drive (D: on most computers) and double-click 
TextbookReportPack.exe.

3. In the Location to Save Files dialog box, accept the default location or 
enter another location. (To browse to another location, click Change. Nav-
igate to the desired folder, then click OK.) Click Next.

4. When the report download is complete, click Finish. You can now generate 
these reports in ReportTool. 

Reports Included in the Textbook Report Pack
• Fine-List(ByGrade&Patron)
• Fine-List(ByHomeroom&Patron)
• Fine-List(ByPatron)
• Fine-List(ByTeacher&Patron)
• Item-List(All-ByTitle)
• Item-List(All-ByTitleWithCondition)
• Item-List(ByPubDateForSelectedLocation)
• Item-List(Deleted-All)
• Loan-List(ByGrade&Patron)
• Loan-List(ByHomeroom&Patron)
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• Loan-List(ByPatron)
• Loan-List(ByTeacher&Patron)
• Patron-List(All)-School
• Patron-List(ByGrade)
• Patron-List(ByHomeroom)
• Stats-Circulation(Item)
• Stats-Circulation(Patron-All)
• Stats-Circulation(Patron-ByGrade)
• Stats-Circulation(Patron-ByHomeroom)
• Stats-Circulation(Patron-ByTeacher)
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